
HP OpenView Service Navigator
Value Pack

Getting Started with Service Configuration for 
Service Navigator 

Software Version: 9.0

for the HP-UX, Microsoft Windows, and Sun Solaris Operating Systems
Manufacturing Part Number: None

Document Release Date: May 2006

Software Release Date: May 2006

© Copyright 2006 Hewlett-Packard Development Company, L.P.



Legal Notices
Warranty. 

The only warranties for HP products and services are set forth in the 
express warranty statements accompanying such products and services. 
Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend. 

Confidential computer software. Valid license from HP required for 
possession, use or copying. Consistent with FAR 12.211 and 12.212, 
Commercial Computer Software, Computer Software Documentation, 
and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Copyright Notices.

©Copyright 2003-2006 Hewlett-Packard Development Company, L.P.

Trademark Notices.

Adobe®, Acrobat® are trademarks of Adobe Systems Incorporated.

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in 
both 32 and 64-bit configurations) on all HP 9000 computers are Open 
Group UNIX 95 branded products.

Intel®Celeron® Intel and Celeron are US registered trademarks of Intel 
Corporation.

Intel Inside Logo w/ MMX The Intel Inside Logo & Pentium are US 
registered trademarks and MMX is a US trademark of Intel Corporation.

Intel Itanium® Logo, Intel, Intel Inside and Itanium are trademarks or 
registered trademarks of Intel Corporation in the U.S. and other 
countries and are used under license. 

Intel® Itanium®Processor Family is a trademark of Intel Corporation in 
the US and other countries and is used under license. 

Microsoft® is a U.S. registered trademark of Microsoft Corporation.

MMX™ is a US trademark of Intel Corporation.
2



MS-DOS® is a U.S. registered trademark of Microsoft Corporation. 

OpenView® is a registered U.S. trademark of Hewlett-Packard Company.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood 
City, California.

OSF, OSF/1, OSF/Motif, Motif, and Open Software Foundation are 
trademarks of the Open Software Foundation in the U.S. and other 
countries.

Pentium® is a U.S. registered trademark of Intel Corporation.

SQL*Net® is a registered U.S. trademark of Oracle Corporation, 
Redwood City, California.

SQL*Plus® is a registered U.S. trademark of Oracle Corporation, 
Redwood City, California.

UNIX® is a registered trademark of the Open Group. 

Windows NT® is a U.S. registered trademark of Microsoft Corporation.

Windows® and MS Windows® are U.S. registered trademarks of 
Microsoft Corporation.

 Java™ and all Java based trademarks and logos are trademarks or  
registered trademarks of Sun Microsystems, Inc. in the U.S. and other  
countries. 
 3



4



Contents
1. Welcome to Service Configuration
What’s New with Service Configuration 9.0? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

2. Take the Tour
Creating Service Hierarchies with Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

About the Main Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
About Configuring an OVO Management Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
About the Service Hierarchy Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
About Adding Child Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Configuring Object Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
About Actions and Nodes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Deploying Service Hierarchies to Service Navigator . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Integrating with Service Desk. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Adding Service Desk Child Objects Based on Rules . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Adding Service Desk Child Objects Manually  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

3. For More Information
Ways to Get Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
What’s This Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Tooltips  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Links in the Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Cautions, Notes, and Tips in the Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
We Welcome Your Comments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
User Documentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
HP OpenView on the Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

4. Using the Service Configuration Console
Starting the Service Configuration Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Getting to Know the Console. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Customizing the Console Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Resizing the Console Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Resizing the Scope and Result Pane  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
Showing and Hiding the Scope Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Expanding and Collapsing the Service Hierarchy  . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Zooming a Map View of Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Showing and Hiding Excluded Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Showing and Hiding Origin Badges  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
5



Contents
Working in Parallel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Disabling Multiple Notifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
Copying and Pasting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Copy and Paste within the Service Hierarchy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Copy and Paste in Dialog Boxes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Copy and Paste between Service Hierarchies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Monitoring the Paste Progress . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Stopping the Paste Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

About Finding Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Using Quick Find . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Changing Quick Find  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Using Advanced Find . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Finding Objects Using the Attributes Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Finding Objects Using the Associations Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Working with the Search Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Advanced Find Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Using Wizards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Using Dialog Boxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Property Dialog Boxes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Edit Dialog Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Standard Dialog Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Exiting the Service Configuration Console. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
6



Documentation Updates
This manual’s title page contains the following identifying information:

• Version number, which indicates the software version.

• Document release date, which changes each time the document is 
updated.

• Software release date, which indicates the release date of this 
version of the software.

To check for recent updates or to verify that you are using the most 
recent edition, visit the following URL:

http://ovweb.external.hp.com/lpe/doc_serv/

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales 
representative for details. 
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Table 1 indicates changes made to this document since the last released 
edition.

Table 1 Document Changes

Chapter Changes

Chapter 1, “Welcome to Service 
Configuration,” on page 11

Added support for some command line tools 
on OVO management server and the 
application server as well.

Changed names of some command line 
tools:

OLD NEW

cadmactivate OvSnvpActivate

cadmexport OvSnvpExport

cadmstart OvSnvpStart

cadmunlock OvSnvpUnlock

Added new command line tools: 

cadm_LoadConfiguration 

cadm_DumpConfiguration (SNVP 8.0 only)

Chapter 2, “Take the Tour,” on page 17 Added information about copying and 
pasting within the service hierarchy.

Added information about inventory for OVO 
management server.

Chapter 4, “Using the Service Configuration 
Console,” on page 47

Added new SNVP installation directory 
location. 

Added information about zooming a map 
view of services.

Added information about copying and 
pasting within the service hierarchy.
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Support
You can visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the 
products, services, and support that HP OpenView offers. 

HP OpenView online software support provides customer self-solve 
capabilities. It provides a fast and efficient way to access interactive 
technical support tools needed to manage your business. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest
• Submit enhancement requests online
• Download software patches
• Submit and track progress on support cases
• Manage a support contract
• Look up HP support contacts
• Review information about available services
• Enter discussions with other software customers 
• Research and register for software training

Most of the support areas require that you register as an HP Passport 
user and log in. Many also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/ \ 
passport-registration.html
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Welcome to Service Configuration
HP OpenView Service Configuration, an add-on product to HP OpenView 
Service Navigator will be your favorite tool for setting up Service 
Navigator service views! Here is why:

❏ Shared objects

Service Configuration is built using state-of-the-art object-oriented 
methodologies. As a result, Service Configuration objects are shared 
objects that can be re-used in multiple service hierarchies. This 
reduces your maintenance effort and keeps your configuration at a 
manageable size. 

❏ Easy to use console

Service Configuration comes with a graphical user interface, 
designed for maximum efficiency and ease of use. Wizards and 
editors help you quickly set up Service Configuration objects.

❏ Status rules out-of-the-box

A selection of the most commonly used propagation and calculation 
rules is available with Service Configuration. This helps you reduce 
the number of status rules required for your configuration.

❏ Mapping OVO messages to objects

It can be cumbersome to map OVO messages to Service Navigator 
services, but with Service Configuration this is fast and easy. You no 
longer need to change and redistribute any message source 
templates. With Service Configuration installed, the OVO 
management server is automatically configured to provide default 
service names which Service Configuration maps to objects.

❏ Service Desk integration

Service Configuration shares a data repository with HP OpenView 
Service Desk. If you are using Service Desk and Service 
Configuration simultaneously, you can access Service Desk objects 
from within Service Configuration and include these objects in your 
service hierarchies, either manually or based on rules using the view 
builder functionality.
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Welcome to Service Configuration
❏ Service Pages integration

Service Pages are secure web pages that enable Service Desk 
customers and specialists to report problems and access data over 
the Internet. Service Pages have been integrated in the Service 
Navigator operator console so that operators can access Service Desk 
data in the context of a specific service. 

❏ Service Configuration documentation and online help

Service Configuration comes with an extensive documentation set. 
For your convenience, the same information is provided in the online 
help and in PDF files. Both formats have unique advantages:

• Online help

Includes field-level help (what’s this help) and dialog-level help 
(help buttons) to help you access the right information where and 
when you need it. 

Use the full-text search function of the online help to search 
through the entire help system for a particular topic.

• PDF format

All guides are available in PDF format so that you can easily 
print out the entire documentation set. The Service 
Configuration for Service Navigator Installation Guide is shipped 
as paper copy with the Service Configuration media.

See the Service Configuration for Service Navigator Concepts Guide and 
the Service Configuration for Service Navigator User’s Guide for more 
information about working with Service Configuration.
Chapter 1 13
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What’s New with Service Configuration 9.0?
What’s New with Service Configuration 9.0?
Service Configuration 9.0 includes the following new functionality:

❏ Web Console integration type (Service Desk integration only)

The new Web Console integration type lets you launch Service Desk 
Web Console from within the Service Navigator. You can perform 
this by starting the Open Service Desk Web Console action from the 
shortcut menu of the selected Service Desk object in Service 
Navigator. This action opens a Web Console Form, which displays the 
properties of a selected Service Desk object and offers a possibility to 
start a number of actions previously defined in Service Desk. 

Refer to the Integrating Service Desk with Service Configuration 
guide for details.

❏ Single step installation

The Service Configuration installation procedure is now much 
simplified by introducing a single step installation using an HP 
OpenView Installer. You can also install or uninstall any of the single 
SNVP components using this installation wizard. For installation 
and uninstallation instructions, refer to the Service Configuration for 
Service Navigator Installation Guide. 

❏ Command line tools

Two new command line tools are introduced: 
cadm_DumpConfiguration (SNVP 8.0 only) and 
cadm_LoadConfiguration. The following command line tools 
changed their names: cadmactivate to OvSnvpActivate, 
cadmexport to OvSnvpExport, cadmstart to OvSnvpStart and 
cadmunlock to OvSnvpUnlock.

❏ Upgrading Service Configuration from version 8.0 to 9.0

Service Configuration upgrade process from version 8.0 to 9.0 is 
documented in this guide.

❏ Inventory for the OVO management server

When selecting an OVO management server, service hierarchies that 
were last deployed to that management server are selected by 
default.
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What’s New with Service Configuration 9.0?
❏ Copy and paste within the service hierarchy

Now it is possible to copy objects (parent object as well as child 
objects) within the same service hierarchy in tree and map views. 
The copied object is pasted under another object as a child.

❏ Ability to zoom a map view of services

You can instantly magnify or reduce your map view of services using 
the ‘zoom’ drop-down list from the toolbar. You can do this by 
choosing a value from a predefined set of proportional zoom ratios 
expressed in percentages, or by selecting a Fit option, which makes 
the whole expanded map visible in the result pane.

❏ User profile to store user relevant data

The user_settings.xml file is no longer used. Instead, a new user 
profile is introduced, the CADMUserProfile.conf. In the 
CADMUserProfile.conf file are stored the details about the last 
loaded hierarchy, main window size and position, ‘don’t show’ 
message preferences and a list of recently used icon and background 
URLs. This file contains settings specified in the Service 
Configuration console.

Login dialog options are stored in the OvObsClient.conf file.

❏ URL support for service icons and backgrounds

In addition to the file names for graphic files for icons and 
backgrounds, Service Configuration now supports also URLs to 
graphics. You can specify an URL in the text field provided and add it 
using the Add URL button in the list with available graphics. 

❏ Icon and background enhancements

All Service Configuration graphic files now reside in the 
<install_dir>\www\images\snvp\ directory on the Service 
Configuration client system, where <install_dir> is an SNVP 
installation directory (\Program Files\HP OpenView\ by default).

❏ Support for some command line tools on OVO management 
server and the application server

Some command line tools are now supported on the OVO 
management server and the application server as well. These tools 
are cadm_ApplyHierarchyRules.bat, cadm_chpwd.bat, 
cadm_Deploy.bat, cadm_DumpHierarchy.bat and 
cadm_LoadHierarchy.bat.
Chapter 1 15



Welcome to Service Configuration
What’s New with Service Configuration 9.0?
❏ New logging and tracing

The 9.0 version of the SNVP brings new logging and tracing. Refer to 
the Service Configuration for Service Navigator Reference Guide for 
more information.

❏ Service Desk 5.0 Integration Support

Service Configuration (SNVP) version 9.0 is built to be used with 
Service Desk version 5. For more information about the Service Desk 
patch level refer to the SNVP README file.
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Take the Tour
Creating Service Hierarchies with Objects
Creating Service Hierarchies with Objects
Service Configuration provides a graphical user interface for configuring 
Service Navigator service views. Before configuring a service hierarchy, 
you will need to start the main console and set up your OVO 
management servers in Service Configuration. This also includes 
importing data from OVO. Then you use the Service Hierarchy Wizard to 
create the initial configuration of a service hierarchy and the hierarchy’s 
root objects. After that, you add child objects to the hierarchy. 

Go to “About the Main Console” on page 19 to start the Service 
Configuration tour.
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Take the Tour
Creating Service Hierarchies with Objects
About the Main Console

When you start the Service Configuration console, the main window is 
displayed with a scope pane on the left and a result pane on the right. 
This console is empty, when no service hierarchies have been configured 
yet or have been migrated from existing Service Navigator installations. 

Go to “About Configuring an OVO Management Server” on page 20 to 
continue with the Service Configuration tour.

Figure 2-1 Service Configuration Main Console

See “Getting to Know the Console” on page 50 for details about the main 
console.
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Creating Service Hierarchies with Objects
About Configuring an OVO Management Server

Before you can start configuring service hierarchies or migrate existing 
service configurations from Service Navigator, you need to set up the 
OVO management server in Service Configuration and import data from 
that server. This data includes OVO users, nodes, and service names in 
messages. It is important that this data is available before you start 
configuring service hierarchies because you need OVO users to grant 
them access to the root objects (and their child objects) of your service 
hierarchies.

To open the dialog box shown in Figure 2-2, select Tools: Options from 
the menu bar. In the Options dialog box, click New. 

Go to “About the Service Hierarchy Wizard” on page 21 to continue with 
the Service Configuration tour. 

Figure 2-2 Setting up a New OVO Management Server
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Creating Service Hierarchies with Objects
About the Service Hierarchy Wizard

The Service Hierarchy Wizard helps you set up the initial configuration 
of a service hierarchy. To configure a new service hierarchy, you need to 
supply general information for the service hierarchy. Optionally you 
could also specify the root objects that serve as entry points into the 
service hierarchy. You also assign OVO users to root objects to grant 
them access to the branch of the hierarchy starting with the root object.

To open the dialog boxes shown in Figure 2-3, select File: New Service 
Hierarchy from the menu bar. The Service Hierarchy Wizard opens and 
displays the General page. Click the Next Page > button to open the 
Root objects page.

Go to “About Adding Child Objects” on page 23 to continue with the 
Service Configuration tour.
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Creating Service Hierarchies with Objects
Figure 2-3 The Service Hierarchy Wizard

TIP Use the command line tool OvSnvpExport to migrate existing service 
configurations from Service Navigator to Service Configuration. See the 
man page OvSnvpExport(1m) for more information about this tool.
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Creating Service Hierarchies with Objects
About Adding Child Objects

Once you have configured the general aspects of a service hierarchy and 
have specified the root objects that will be the toplevel objects in your 
hierarchy, you manually add child objects to the service hierarchy.

If you have HP OpenView Smart Plug-ins installed that discover service 
hierarchies automatically, you can also copy branches from the 
discovered object hierarchies to your own hierarchy. See “Copy and Paste 
between Service Hierarchies” on page 66.

To open the dialog box shown in Figure 2-4, select an object in the map 
view or in the tree view and select Edit: Add Child Object from the 
menu bar. In the Add Child Object dialog box, click New to open a dialog 
box where you can create a new child object. Alternatively, select an 
already existing child object and add it to the service hierarchy.

TIP Easier way to add an already existing child object to the service 
hierarchy is to use Copy and Paste items from Edit menu, or from 
objects’ shortcut menu in the scope or result pane. See See “Copy and 
Paste within the Service Hierarchy” on page 64 for more information.
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Creating Service Hierarchies with Objects
Go to “Configuring Object Status” on page 25 to continue with the 
Service Configuration tour.

Figure 2-4 Manually Adding Service Configuration Child Objects
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Configuring Object Status
Configuring Object Status
Service Navigator considers multiple factors when calculating the status 
of an object: the status of the child objects is of influence as well as the 
status of messages that target the object. Status calculation rules define 
the algorithm that is being used. Status propagation rules define how 
child objects present their status to their parent objects. And status 
weighting allows you to assign a weight to objects that you consider more 
important than other objects.

When objects are added to a service hierarchy, default status rules are 
used and a default weight is assigned. If you are not satisfied with the 
default configuration, you can create your own rules and assign them 
manually to the objects. 

The Service Configuration Calculation Rule Editor and Propagation Rule 
Editor are your main tools for configuring status rules. Status rules are 
shared objects within Service Configuration which means that you can 
associated one rule with multiple objects. This keeps your maintenance 
efforts at a minimum.

To open the dialog boxes shown in Figure 2-5, select Tools: 
Propagation Rule Editor and Tools: Calculation Rule Editor from 
the menu bar. Note that you cannot use both editors in parallel.

Go to “About Actions and Nodes” on page 27 to continue with the Service 
Configuration tour.
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Configuring Object Status
Figure 2-5 Status Rule Editors
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About Actions and Nodes
About Actions and Nodes
Actions are URLs or programs that, when executed on a managed object, 
either launch a web browser at a specified URL or run a command. The 
advantage of associating actions with objects in Service Configuration is 
that the operator does not have to first select the object in the object pane 
before running the action in the Service Navigator operator console. 

Nodes serve as target systems for actions or as hosting nodes for service 
resources.

The Service Configuration Action Editor and Node Editor are your main 
tools for configuring and managing actions and nodes. Actions and nodes 
are shared objects within Service Configuration which means that you 
can associated one action or node with multiple objects. This keeps your 
maintenance efforts at a minimum.

To open the dialog boxes shown in Figure 2-6, select Tools: Action 
Editor and Tools: Node Editor from the menu bar. Note that you 
cannot use both editors in parallel.

Go to “Deploying Service Hierarchies to Service Navigator” on page 29 to 
continue with the Service Configuration tour.
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About Actions and Nodes
Figure 2-6 The Action and Node Editors
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Deploying Service Hierarchies to Service Navigator
Deploying Service Hierarchies to Service 
Navigator
When you are satisfied with your service hierarchy, you are ready to 
deploy it to the OVO management server where the Service Navigator 
service engine is running. You can choose to have Service Configuration 
deploy the hierarchy automatically, or manually using the command line 
tool cadmsnd. See the man page cadmsnd(1m) for more information 
about this tool.

To open the dialog box shown in Figure 2-7, select File: Deploy Service 
Hierarchies from the menu bar.

NOTE When selecting an OVO management server, service hierarchies that 
were last deployed to that management server are selected by default.
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Deploying Service Hierarchies to Service Navigator
Go to “Integrating with Service Desk” on page 31 to complete the Service 
Configuration tour.

Figure 2-7 Deploying Service Hierarchies
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Integrating with Service Desk
If you have Service Configuration installed on an existing HP OpenView 
Service Desk installation, you can take advantage of the fact that Service 
Desk and Service Configuration share a data repository. This means that 
you have (read) access to Service Desk objects in Service Configuration 
and that you can use these objects in your service hierarchies. 

You can build service hierarchies with Service Desk objects manually or 
based on service hierarchy rules. Go to “Adding Service Desk Child 
Objects Based on Rules” on page 32 to learn more about service 
hierarchy rules.
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Adding Service Desk Child Objects Based on Rules

Service hierarchy rules represent the core component of the Service 
Configuration view builder. Service hierarchy rules are applied to objects 
stored in the Service Desk database. Service Desk objects that meet the 
criteria of the rules are added to Service Configuration service 
hierarchies.

For example, you could set up a rule filter that adds objects of the type 
“configuration item”, where the category equals “software”. After the rule 
has been applied, Service Desk configuration items of the category 
“software” are added to the hierarchy that uses the rule. When new 
configuration items with the category “software” are added to Service 
Desk, they are also added to the service hierarchy the next time the rule 
is applied.

Where the objects are added depends on the type of service hierarchy 
rule. Service Configuration distinguishes between two types of rules:

❏ Child object rules

Child object rules are associated with Service Configuration objects 
(objects that are not mapped to Service Desk objects). Child object 
rules have a child filter only, which adds Service Desk objects as child 
objects below the Service Configuration object. Child object rules are 
useful as a starting point in a hierarchy. For example, you can add 
child object rules to root objects in order to add a layer of Service 
Desk objects below the root objects.

❏ Parent-and-child object rules

Parent-and-child object rules are associated with service hierarchies, 
not with individual objects. The rules have both a parent and a child 
filter: if a service hierarchy contains an object that is mapped to a 
Service Desk object and that matches the parent filter of the rule, 
then the child filter will add all matching Service Desk objects as 
children below the parent.

One powerful aspect of parent-and-child object rules is that the child 
filter selects Service Desk objects based on the objects’ parent-child 
relations in Service Desk. This means that for a parent-and-child 
object rule to find child objects in Service Desk, these objects must be 
related in Service Desk.
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The Service Configuration Child Object Rule Editor and 
Parent-and-Child Object Rule Editor are your main tools for configuring 
and managing service hierarchy rules. Service hierarchy rules are 
shared objects within Service Configuration which means that you can 
associated one rule with multiple objects or hierarchies. This keeps your 
maintenance efforts at a minimum.

To open the dialog boxes shown in Figure 2-8, select Tools: Child 
Object Rule Editor and Tools: Parent-and-Child Object Rule 
Editor from the menu bar. Note that you cannot use both editors in 
parallel.

Go to “Adding Service Desk Child Objects Manually” on page 35 to 
continue with the Service Configuration tour.
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Figure 2-8 The Service Hierarchy Rules Editors
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Adding Service Desk Child Objects Manually

To insert Service Desk child objects manually in service hierarchies, use 
the Add Child dialog box. You can also map existing Service 
Configuration objects to Service Desk objects.

To open the dialog box shown in Figure 2-9, select an object in the map 
view or in the tree view and select Edit: Add Child Object from the 
menu bar.

NOTE Service Configuration automatically extends the Add Child dialog box 
shown in Figure 2-4 on page 24 with the Service Desk features shown in 
Figure 2-9 on page 35 when it is installed on an existing Service Desk 
installation.

The tour through Service Configuration is now finished.

Figure 2-9 Manually Adding Service Desk Child Objects
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Ways to Get Help
Service Configuration for Service Navigator provides help files to guide 
you through the tasks you want to perform.

Help is available from several locations: 

❏ Online Help 

See “Online Help” on page 38.

❏ What’s This Help

See “What’s This Help” on page 39.

❏ Tooltips

See “Tooltips” on page 39.

Online Help

You are now reading the Service Configuration online help. The online 
help is displayed in the help viewer. To open the online help from within 
Service Configuration, do one of the following:

❏ Default help topic

Choose Contents and Index from the Help menu to open the 
default online help topic. 

❏ Help topic related to the active dialog box

Do one of the following to find help related to the dialog box you work 
in. If there is no specific help for the active dialog, the default help 
topic will be displayed. 

• Choose Service Configuration Help (F1) from the Help menu. 

• Click the Help button in the toolbar. 

• Press F1. 

• Click the Help button in the dialog box.

From the help topic displayed at first, you can navigate to other help 
topics. 

See also “What’s This Help” on page 39.
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What’s This Help

What's this help gives you a short explanation of an item in a window or 
dialog box of Service Configuration. The explanation of what's this help 
is usually longer than the description given by the tooltip. 

To find what's this help:

Several ways exist to find what’s this help in the Service Configuration 
application:

1. Activate what’s this help:

• Choose What's This? from the Help menu if the dialog box.

• Click the What’s This? button in the toolbar of the dialog box.

2. The cursor is now changed into the question mark cursor.

3. Click on the item in the dialog box for which you want an 
explanation. 

TIP A quick and easy way to display what’s this help is to click on the item in 
the dialog box for which you want what’s this help and to press SHIFT+F1.

See also “Tooltips” on page 39.

Tooltips

Tooltips give a short description of a toolbar button.

To find a tooltip, simply rest the mouse pointer for a moment on the 
toolbar button about which you want information. A text box giving 
information of the item will be displayed.

See also “Ways to Get Help” on page 38.
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Links in the Online Help
Blue underlined text is linked to related topics that appear in various 
ways, depending on the content of the linked information: 

❏ Glossary information

Popup dialog boxes with a yellow background display glossary 
information. 

❏ Other topics

Links to other topics replace the existing text in the help window. 
Use the Back button to return to your starting place. 

Figure 3-1 shows an online help topic with links to glossary information 
and links to related topics.
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Figure 3-1 Online Help Topic Displaying Links

See also “Cautions, Notes, and Tips in the Online Help” on page 42.
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Cautions, Notes, and Tips in the Online Help
 Cautions

Cautions show important information that may 
significantly impact your work.

 Notes

Notes show additional information that may require 
your attention. 

 Tips

Tips present helpful information. 

See also “Support” on page 9.
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We Welcome Your Comments
Your comments and suggestions help us to understand your needs, and 
enable us to meet them. We are interested in what you think of this help 
system, and alert us to problems or suggest improvements.

NOTE If you encounter serious errors that impair your ability to use the 
product, you should contact the HP Response Center, or your support 
representative. To find contact information of the nearest HP Response 
Center, use the following URL: http://support.openview.hp.com

For the latest updates on news and manuals, view the HP OpenView 
Internet pages, at the following URL:

http://www.managementsoftware.hp.com/ 

Through one of the above channels, you should also be able to provide 
comments about this document or any part of the Service Configuration 
documentation.

See also “User Documentation” on page 44.
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User Documentation
Information about Service Configuration for Service Navigator is also 
available in PDF format on the Service Navigator Value Pack 
installation CD-ROMs. 

You can open and print any .pdf file by starting the Acrobat Reader and 
navigating to the directory that contains the .pdf file you want to view. To 
open and view a file, double-click the name of the file you want to view. 

NOTE The PDF files have been provided for your convenience. They contain the 
same information found in the online help.

❏ Service Configuration for Service Navigator Installation 
Guide

The Service Configuration for Service Navigator Installation Guide 
guide contains detailed instructions for installing Service 
Configuration. It also describes possible installation and scalability 
scenarios to help you choose the best possible fit for your 
environment.

❏ Service Configuration for Service Navigator Concepts Guide

The Service Configuration for Service Navigator Concepts Guide 
explains the concepts behind Service Configuration.

❏ Service Configuration for Service Navigator User’s Guide

The Service Configuration for Service Navigator User’s Guide 
describes how to use Service Configuration to create service 
hierarchies for presentation in the Service Navigator operator 
console.

❏ Service Configuration for Service Navigator Reference Guide

The Service Configuration for Service Navigator Reference Guide 
contains reference information such as keyboard shortcuts, the 
behavior of menu items and toolbar buttons, descriptions of 
system-provided propagation and calculation rules, and so on.
Chapter 344



For More Information
User Documentation
❏ Integrating Service Desk with Service Configuration for 
Service Navigator

The Integrating Service Desk with Service Configuration for Service 
Navigator guide explains how you can integrate Service Desk with 
Service Configuration.

See also “HP OpenView on the Web” on page 46.
Chapter 3 45



For More Information
HP OpenView on the Web
HP OpenView on the Web
Access the following URL to load the HP OpenView web site:

http://www.managementsoftware.hp.com/ 

See also “We Welcome Your Comments” on page 43.
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Starting the Service Configuration Console
When you start the Service Configuration client, the console usually 
appears without requiring further input from you. Input may be required 
from you in the following cases:

❏ Failure to connect

The error message Failed to connect. appears when the console 
encounters a problem when trying to connect to the UI server (the 
application server). This happens, for example, when the UI server 
has not been installed yet or is not running, or when the system 
administrator has changed the password. When you are sure that 
the UI server is installed and running, acknowledge the error 
message. The Login dialog box appears. Enter the required 
information as described below and click OK to start the Service 
Configuration console.

❏ Service Desk users only

Service Desk can be configured to always display the Service Desk 
Login dialog box. If this is configured in the System Panel of the 
Service Desk Administrator Console, Service Configuration users are 
also always presented with the Service Configuration Login dialog 
box. Enter the required information as described below and click OK 
to start the Service Configuration console.

TIP If the administrator has changed the password or if you would like to 
connect to another UI server, enter the new data in the Login dialog box, 
then modify the appropriate information on the General tab of the 
Options dialog box. The next time you start the console, the new 
password and the new UI server will be used.
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Starting the Service Configuration Console
To start the Service Configuration console:

1. Select Programs from the Start menu. Choose HP OpenView and 
select HP OpenView SNVP. The Service Configuration console 
opens.

The Service Configuration Login dialog box may open if input is 
required from you.

2. The User name field displays the default user system. The user 
name cannot be changed.

3. In the Password field, type the password openview. This is the 
default password of the default user. If your system administrator 
has changed this password, type the new password.

4. In the UI server field, type the name of the computer where the 
Service Configuration server is installed. This is the system where 
the Service Desk application server is running.

5. Click OK. The Login dialog box closes and the Service Configuration 
main console is displayed.

See also “Exiting the Service Configuration Console” on page 88.
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Getting to Know the Console
When you start the Service Configuration console, you see the main 
window as show in Figure 4-1 on page 50.

Figure 4-1 Main Window of the Service Configuration Console

Menu bar
ToolbarDescription bar

Scope pane

Result pane
with map view

with tree view
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The main window of the Service Configuration console is divided into the 
following main areas:

❏ Scope pane with tree view

The left pane, the scope pane, displays the service hierarchy of your 
current service view. This is a hierarchical tree diagram that helps 
you visualize what your current service view looks like when viewed 
with the operator console. Objects in the service hierarchy can be 
expanded or collapsed by double-clicking them or by clicking the 
+ (plus) or - (minus) signs. 

❏ Result pane with map view

The right pane, the result pane, displays a map view of the current 
service hierarchy. The map view always displays the object that is 
currently selected in the scope pane as well as the children of that 
object.You can specify how many levels will be displayed below each 
parent object when selected in a map.

The top of the Service Configuration console contains the following tools:

❏ Menu bar

The menu bar is the strip of pull-down menus at the very top of the 
Service Configuration console. You can use these menus to perform 
operations throughout the Service Configuration console.

❏ Toolbar

The toolbar is the row of icons just below the menu bar. The toolbar 
provides menu choices that apply to the objects in the scope pane and 
result pane. The toolbar also contains a ‘zoom’ drop-down list ( See 
“Zooming a Map View of Services” on page 57), and a drop down list 
of available service hierarchies for quick access to another hierarchy. 

❏ Description bar

The description bar displays the name of the object that is currently 
selected in the scope pane.

See also “Customizing the Console Window” on page 52.
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Customizing the Console Window
Each time you start the Service Configuration console, it opens with a 
default window layout and size. You can change this default layout for 
your current console session if it does not match your working style. You 
can customize the console as follows:

❏ Resizing the Console Window

See “Resizing the Console Window” on page 53.

❏ Resizing the Scope and Result Pane

See “Resizing the Scope and Result Pane” on page 54.

❏ Showing and Hiding the Scope Pane

See “Showing and Hiding the Scope Pane” on page 55.

❏ Expanding and Collapsing the Service Hierarchy

See “Expanding and Collapsing the Service Hierarchy” on page 56.

❏ Zooming a Map View of Services

See “Zooming a Map View of Services” on page 57.

❏ Showing and Hiding Excluded Objects

See “Showing and Hiding Excluded Objects” on page 58.

❏ Showing and Hiding Origin Badges

See “Showing and Hiding Origin Badges” on page 59.
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Resizing the Console Window

Resize the console if you want to increase or decrease the overall size of 
the console.

To resize the console:

1. Move the mouse to any corner of the console. The mouse pointer 
changes into the resize pointer.

2. Drag the corner to the correct size. To drag the corner, click and hold 
the left mouse button and move the mouse before you release the 
button.

If you reduce the size of the console so that not all content is visible, 
vertical scroll bars appear.

Any changes to the console are automatically saved in the 
CADMUserProfile.conf file. This file contains settings specified in the 
Service Configuration console.

See also “Resizing the Scope and Result Pane” on page 54.
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Resizing the Scope and Result Pane

You can increase and decrease the size of the scope and result pane by 
dragging the vertical divider between the two panes. Increasing the 
width of the scope pane can be useful when working with large service 
hierarchies.

To resize the scope and result pane:

1. Point your cursor to the vertical bar between the scope pane and the 
result pane. 

2. When you cursor becomes a double-headed arrow, drag the vertical 
divider to the left or right.

Any changes to the console are automatically saved in the 
CADMUserProfile.conf file. Except some parameters related to tracing, 
you cannot specify your preferences directly in this file. It just presents a 
summary of settings specified in the Service Configuration console.

See also “Showing and Hiding the Scope Pane” on page 55.
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Showing and Hiding the Scope Pane

Sometimes you may not want to work with the service hierarchy in the 
scope pane, but focus instead on the map view that is displayed in the 
result pane. You can temporarily hide the scope pane if you do not need 
it.

To show and hide the scope pane:

1. To show the scope pane, select Show Scope Pane from the View 
menu of the Service Configuration console. A check mark appears on 
the menu item to indicate that the service hierarchy is displayed. 
This is the default setting.

2. To hide the scope pane, select Show Scope Pane from the View 
menu of the Service Configuration console. If the menu item is not 
checked, the service hierarchy does not appear in the console.

Any changes to the console are automatically saved in the 
CADMUserProfile.conf file. Except some parameters related to tracing, 
you cannot specify your preferences directly in this file. It just presents a 
summary of settings specified in the Service Configuration console.

See also “Resizing the Console Window” on page 53.
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Expanding and Collapsing the Service Hierarchy

You can expand and collapse the service hierarchy in the scope pane and 
in the result pane to display more or fewer children. How many levels are 
expanded or collapsed depends on the presentation property of the 
object. The default presentation depth is two (2). This includes the object 
itself and one more level below the object.

To expand or collapse the service hierarchy:

❏ Scope pane

• Expand the service hierarchy

Click the plus sign (+) next to the object or double-click the object.

• Collapse the service hierarchy

Click the minus sign (-) next to the object or double-click the 
object.

❏ Result pane

• Expand the service hierarchy

Click the plus sign (+) below the object label.

• Collapse the service hierarchy

Click the minus sign (-) below the object label.

Double-clicking an object in the result pane displays the object’s 
properties.

See also “Showing and Hiding Origin Badges” on page 59.
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Zooming a Map View of Services

You can instantly magnify or reduce your map view of services using the 
‘zoom’ drop-down list from the toolbar.

To use the ‘zoom’ drop-down list:

❏ Select one of zoom ratios

Select a value from a predefined set of proportional zoom ratios 
expressed in percentages, from 5% to 100%, or

❏ Select Fit option

This option selects such zoom level, which makes the whole 
expanded map visible in the result pane.

See also “Expanding and Collapsing the Service Hierarchy” on page 56.
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Showing and Hiding Excluded Objects

If you generate a service hierarchy automatically, for example by way of 
Smart Plug-in (SPI) service discovery or with service hierarchy rules 
(Service Desk integration only), you can choose to exclude objects that 
you do not want to appear in the service hierarchy. Objects that are 
excluded are by default hidden from view. You can, however, make 
excluded objects visible in the console.

To show or hide excluded objects:

1. To show excluded objects, select the Show Excluded Objects item 
from the View menu of the Service Configuration console. A check 
mark appears on the menu item to indicate that excluded objects are 
shown in the console. 

In the console, excluded objects now carry a badge on the top left as 
shown in Figure 4-2.

2. To hide excluded objects, select the Show Excluded Objects item 
from the View menu of the Service Configuration console. If the 
menu item is not checked, excluded objects do not appear in the 
console. This is the default setting.

Figure 4-2 Excluded Badge

See also “Showing and Hiding Origin Badges” on page 59.

Excluded
badge
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Showing and Hiding Origin Badges

An origin badge indicates how an object was added to a service 
hierarchy. Service Configuration distinguishes between the following 
badges:

 Manually added
This badge indicates that the object was manually 
added. This means that the object was not added by 
way of Smart Plug-in discovery or service hierarchy 
rules (Service Desk integration only).

 Discovered
This badge indicates that the object was added by SPI 
service discovery.

 Generated (Service Desk integration only)
This badge indicates that the object was added by 
service hierarchy rules.

By default, origin badges are not shown in the console. If you do want to 
display origin badges, maybe because you want to find out which objects 
were added manually, you can choose to show them as described below.

To show or hide origin badges:

1. To show badges, select the Show Origin Badges item from the 
View menu of the Service Configuration console. A check mark 
appears on the menu item to indicate that badges are displayed in 
the console. This is the default setting.

In the console, all objects now carry a badge on the top left.

2. To hide badges, select the Show Origin Badges item from the View 
menu of the Service Configuration console. If the menu item is not 
checked, badges do not appear in the console. This is the default 
setting.

See also “Showing and Hiding Excluded Objects” on page 58.
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Working in Parallel
Service Configuration allows up to ten (10) parallel instances of the 
client console. This means that up to ten users can be logged into a 
console simultaneously. (All users use the same user name and 
password.)

If desired, all users can view the same service hierarchy at the same 
time. However, the user who first makes any changes to the service 
hierarchy locks the service hierarchy to prevent other people from 
making changes at the same time. This does not affect the other users as 
long as they only view the service hierarchy. If another user tries to 
modify the locked service hierarchy, a confirmation message similar to 
the following appears:

Figure 4-3 Service Hierarchy Locked

When you encounter this message, you should click Cancel, contact the 
user who has locked the service hierarchy, and enquire about the status 
of the changes. Once the other user has saved the service hierarchy (and 
thereby unlocked it), you can reload the hierarchy and edit it. 

If you click Continue in the dialog box, you will be allowed to make 
changes and to save them but you will thereby overwrite the changes 
other users have made to the same service hierarchy.
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NOTE Do not edit the discovery hierarchy when SPI discovery processes are 
running. By editing the hierarchy, you lock it so that the discovery 
processes cannot write the discovered data into the hierarchy. The 
discovery process will wait until the hierarchy is unlocked and then write 
the new data into the hierarchy. However, this may cause significant 
delays in your discovery schedules. You can also use the command line 
tool OvSnvpUnlock(1m) to unlock the default discovery hierarchy.

See also “Starting the Service Configuration Console” on page 48.
Chapter 4 61



Using the Service Configuration Console
Disabling Multiple Notifications
Disabling Multiple Notifications
The Service Configuration console displays a number of message dialog 
boxes to draw your attention to possible consequences or side effects of 
your actions. If you feel confident that you understand how to use the 
console, you can disable each message so that it does not appear again. 

Figure 4-4 shows a warning message for modifying an object that 
appears in multiple locations in the hierarchy. Once disabled these 
objects will be modified immediately without requiring any input from 
you.

Figure 4-4 Warning Message

Service Configuration distinguishes between the following types of 
messages:

❏ Warning and information messages

For each warning and information message, select the check box 
Don’t show this message in the future, to prevent it from 
appearing again.

❏ Confirmation messages

For each confirmation message, select the check box In the future, 
always continue without showing this message. As 
confirmation messages require input from you, disabled confirmation 
messages always assume the default action Yes or Continue.

❏ In progress, finished, and error messages

In progress, finished, and error messages cannot be disabled.
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Copying and Pasting
You can use copy and paste in the following situations: 

❏ Copy and Paste within the Service Hierarchy

See “Copy and Paste within the Service Hierarchy” on page 64.

❏ Copy and Paste in Dialog Boxes

See “Copy and Paste in Dialog Boxes” on page 65.

❏ Copy and Paste between Service Hierarchies

See “Copy and Paste between Service Hierarchies” on page 66.
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Copy and Paste within the Service Hierarchy

In tree and map views, you can copy objects (parent object as well as 
child objects) within the same service hierarchy. The copied object is 
pasted under another object as a child.

To use copy and paste within the service hierarchy:

❏ Copy

Select an object and choose Copy from the Edit menu or from the 
shortcut menu. Note that root objects are not copied. 

❏ Paste

Select an object under which you want to place the copied object(s), 
and choose Paste from the Edit menu or from the shortcut menu.

See also “Copy and Paste between Service Hierarchies” on page 66.
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Copy and Paste in Dialog Boxes

In dialog boxes, you can copy and paste or cut and paste information in 
text fields. 

To use copy and paste in dialog boxes:

To duplicate information fast and easy, you can use copy and paste:

❏ Copy

To copy information, select the information and press CTRL+C 
(Windows) or ALT+C (UNIX). 

❏ Paste

To paste information, place the cursor where you want to place the 
information, and press CTRL+V (Windows) or ALT+V (UNIX).

❏ Cut

Depending on the situation you are in, you can also use cut and 
paste. To cut information, press CTRL+X (Windows) or ALT+X 
(UNIX).

See also “Copy and Paste between Service Hierarchies” on page 66.
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Copy and Paste between Service Hierarchies

In tree and map views, you can copy objects branches (parent object with 
related child objects) from one service hierarchy to another service 
hierarchy. The copied objects are duplicated in the target service 
hierarchy.

To use copy and paste between service hierarchies:

❏ Copy

To copy an object branch, select the parent object and choose Copy 
between Service Hierarchies from the Edit menu or from the 
shortcut menu. Note that root objects are not copied. 

The object branch is placed onto the clipboard and you are asked to 
load another service hierarchy where you can paste the copied object 
branch. (You may be prompted to save the current service hierarchy 
before another hierarchy can be loaded.) 

❏ Paste

To paste an object branch, select the parent object under which you 
want to place the copied object branch, and choose Paste between 
Service Hierarchies from the Edit menu or from the shortcut 
menu.

CAUTION The paste process may take a long time if there are many objects to 
paste. It is therefore recommended to monitor the progress as 
described in “Stopping the Paste Process” on page 67. If the paste 
operation fails due to insufficient memory on your console system, 
increase the available memory and try again.
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NOTE If you try to paste an object into the hierarchy more than once, the 
following confirmation message appears:

The following objects exist already in the target view. If you 
continue, these objects and their status calculation will be 
overwritten. 

See also “Monitoring the Paste Progress” on page 67.

Monitoring the Paste Progress

Pasting a branch of a service hierarchy from the clipboard into another 
service hierarchy can take a long time, if the branch is very large. While 
the hierarchy branch is being pasted, a message informs you about the 
progress. Service Configuration also informs you about the successful 
completion of the operation. Click Close to close the Paste Finished 
dialog box.

See also “Stopping the Paste Process” on page 67.

Stopping the Paste Process

If the paste process hangs, you may want to stop it by clicking the Stop 
button in the Paste in Progress dialog box. Beware though that stopping 
this process may result in inconsistent data and is therefore not 
recommended. 

TIP If you choose to stop the paste process, you should reload the original 
service hierarchy to remove any partially pasted branches. This only 
works if you do not save the service hierarchy after having modified it.

See also “Monitoring the Paste Progress” on page 67.
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About Finding Objects
The search facilities in Service Configuration are very versatile. You can 
find Service Configuration objects using any detail in the object.

There are several ways to search:

❏ Basic find features

In dialog boxes that contain object lists, for example the Calculation 
Rule Editor, you can place the cursor in the list and type the first 
character of the object you are looking for. The first object that 
matches the typed character will be highlighted. To find the next 
object, type the character again. If the list has more than one column, 
Service Configuration searches the column that is currently sorted.

Some dialog boxes, for example the Add Child Object dialog box, 
contain a Look for field where you can type a few characters of the 
object you are looking for. When you click Find Next, the first object 
that matches the search string is highlighted in the list. Service 
Configuration always searches all columns.

❏ Quick find features

With the Quick Find dialog box, you search one object type only. See 
“Using Quick Find” on page 69.

❏ Advanced find features

With the Advanced Find dialog box, you can search with 
customizable criteria. See “Using Advanced Find” on page 71.
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Using Quick Find

With the Quick Find dialog box, you can find an object from a list of 
objects of a given type. How you use Quick Find depends on what you 
want to do:

❏ Advanced Find and Specify Filter

Quick Find helps you finding and selecting a value from a list.

❏ Mapping objects to Service Desk objects

Quick Find helps you finding a Service Desk object in a list.

To use quick find:

1. Open the Quick Find dialog box:

• Advanced Find and Specify Filter

a. Click the Quick Find button to the right of the Value field. 
The Quick Find dialog box opens.

b. The Object type field displays the type of object that will be 
searched.

• Mapping objects to Service Desk objects

a. Click the Quick Find button to the right of the Object name 
field in the Mapping to Service Desk Objects dialog box. The 
Quick Find dialog box opens.

b. The Object type field displays the type of object that will be 
searched. You can select another object type from the list, if 
you want.

c. If there are many objects in the list, click the Advanced 
Find button to define a more sophisticated search pattern. 
See “Using Advanced Find” on page 71 for more information.
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2. In the Quick Find dialog box, use the scroll bar to navigate to the 
object you are looking for.

a. To find an object, type a few characters of the object you are 
looking for in the Look for field. 

b. Click Find Next. 

Service Configuration selects the first object that matches the 
typed characters. If the object found is not the one you are 
looking for, click Find Next again or change the characters you 
typed into the Look for field.

Service Configuration always searches all columns.

3. Click Choose to choose the object and close the Quick Find dialog 
box.

See also “Changing Quick Find” on page 70.

Changing Quick Find

You can change the way objects are listed in the Quick Find dialog box:

❏ Sort order

To change the sort order of the results listed in the Quick Find dialog 
box, click in the header of the column you want to sort. 

❏ Column order

To change the column order, click and drag the column header to 
another position. 

See also “Using Quick Find” on page 69.
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Using Advanced Find

With the Advanced Find dialog box, you can find objects using 
customizable criteria. To find an object, you can base your search on 
attributes and on associations:

❏ Attributes tab

Lets you specify a search pattern based on the attributes of an object, 
for example, the name or the description. See “Finding Objects Using 
the Attributes Tab” on page 72.

❏ Associations tab

Lets you specify a search pattern based on the associations an object 
has with other objects, for example associations with calculation 
rules. See “Finding Objects Using the Associations Tab” on page 74.

See “Advanced Find Operators” on page 77 for more information about 
search operators in Advanced Find.

The objects you find with the Advanced Find dialog box comply to all 
criteria you entered in both tabs. The results of your search are displayed 
on the Objects Found tab. See “Working with the Search Results” on 
page 76 for more information.

NOTE When searching for Service Configuration objects, only a limited set of 
attributes and associations is available for selection. When searching for 
Service Desk objects, the same attributes and associations are available 
that can also be used in Service Desk’s advanced find.
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Finding Objects Using the Attributes Tab

Use the following procedure to find objects based on their attributes. 

NOTE Searches using advanced find are always case-sensitive.

To find objects using the Attributes tab:

1. Click Advanced Find in one of the following dialog boxes:

• Add Child: to find child objects. 

• Node Editor: to find nodes.

• Choose Node: to find hosting or target nodes.

The Advanced Find dialog box opens and displays the By Attribute 
tab by default.

2. The Object type field is only available for selection when searching 
for Service Desk objects in the database. If so, select the Service Desk 
object type you want to search for.

3. Select the attribute you want to use from the Field drop-down menu. 
For Service Desk objects, you can choose from up to three levels of 
attributes.

4. Select the operator you want to use from the Operator drop-down 
list. See “Advanced Find Operators” on page 77 for more information 
about available search operators.

5. Type the value you want to match in the Value field or click the 
Quick Find button to open the Quick Find dialog box. See “Using 
Quick Find” on page 69 for more information about Quick Find.

6. Click Add Criteria to add the criterion to the summary of search 
criteria. To edit the criterion, double-click it in the summary section 
or select it and click Edit.

7. To add additional criteria, repeat steps 3 through 6. 

If you add more than one criterion to the list, only objects that meet 
all of the search criteria are found. 
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8. Click Find Now to start the search. The results of your search are 
displayed on the Objects Found tab. See “Working with the Search 
Results” on page 76 for more information.

Or, select the By Association tab to add additional search patterns 
based on the object’s associations. See “Finding Objects Using the 
Associations Tab” on page 74.

9. When you have found the object you are looking for, select it on the 
Objects Found tab and click Choose. If you are not satisfied with the 
search results, revise your search criteria and try again.

NOTE If you are searching for nodes, click Apply to add the nodes found to 
the list of nodes in the Node Editor or in the Choose Node dialog box.

TIP To remove a single criterion, select it and click Remove. Click Clear to 
remove all criteria at once.

See also “Finding Objects Using the Associations Tab” on page 74.
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Finding Objects Using the Associations Tab

Use the following procedure to find objects based on their associations.

NOTE Searches using advanced find are always case-sensitive.

To find objects using the Associations tab:

1. Click Advanced Find in one of the following dialog boxes:

• Add Child: to find child objects. 

• Node Editor: to find nodes.

• Choose Node: to find hosting or target nodes.

Select the By Association tab. 

2. The Object type field is only available for selection when searching 
for Service Desk objects in the database. If so, select the Service Desk 
object type you want to search for.

3. Select the associated object type you want to use from the Field 
drop-down menu. For Service Desk objects, you can choose from up to 
two levels of associated object types.

4. Select the operator you want to use from the Operator drop-down 
list. See “Advanced Find Operators” on page 77 for more information 
about available search operators.

5. Type the value you want to match in the Value field or click the 
Quick Find button to open the Quick Find dialog box. See “Using 
Quick Find” on page 69 for more information about Quick Find.

6. Click Add Criteria to add the criterion to the summary of search 
criteria. To edit the criterion, double-click it in the summary section 
or select it and click Edit.

7. To add additional criteria, repeat steps 3 through 6. 

If you add more than one criterion to the list, only objects that meet 
all of the search criteria are found.
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8. Click Find Now to start the search. The results of your search are 
displayed on the Objects Found tab. See “Working with the Search 
Results” on page 76 for more information.

Or, select the By Attributes tab if you want to add additional search 
patterns based on the object’s attributes. See “Finding Objects Using 
the Attributes Tab” on page 72.

9. If you have found the object you were looking for, select it and click 
Choose. If you are not satisfied with the search results, revise your 
search criteria and try again.

NOTE If you are searching for nodes, click Apply to add the nodes found to 
the list of nodes in the Node Editor or in the Choose Node dialog box.

TIP To remove a single criterion, select it and click Remove. Click Clear to 
remove all criteria at once.

See also “Finding Objects Using the Attributes Tab” on page 72.
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Working with the Search Results

The results of your search are displayed on the Objects Found tab. If no 
objects were found, refine your search criteria and start another search.

NOTE Searches using advanced find are always case-sensitive.

To work with the search results:

1. Define your search patterns as described in “Finding Objects Using 
the Attributes Tab” on page 72 and “Finding Objects Using the 
Associations Tab” on page 74.

2. Click Find Now to start the search. The search results are displayed 
on the Objects Found tab.

3. Work with the search results:

• No results

If the search process does not find any objects that match your 
search criteria, it responds with the statement No results. In 
this case you should revise your search criteria and start the 
search again. To edit a criterion, double-click it in the summary 
section or select it and click Edit.

• Objects found

If the search process is successful, it displays a list of matching 
objects on the Objects Found tab. Double-click the desired object 
or select it and click Choose. This closes the Advanced Find 
dialog box and adds the object to the service hierarchy.

NOTE If you are searching for nodes, click Apply to add the nodes 
found to the list of nodes in the Node Editor or in the Choose 
Node dialog box.

4. Click Close to close the Advanced Find dialog box if it is still open.

See also “Finding Objects Using the Attributes Tab” on page 72 and 
“Finding Objects Using the Associations Tab” on page 74.
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Advanced Find Operators

The following table lists and explains the operators that are available in 
Advanced Find:

Table 4-1 Advanced Find Operators

Operator Example Interpreted As

contains Description contains “Word” “Visio” 
“save”

Finds all objects whose description 
contains all of the keywords “Word” 
and “Visio” and “save”.

doesn’t contain Description doesn’t contain “toner 
cartridge”

Finds all objects whose description 
does not contain the keyword “toner 
cartridge”.

doesn’t exist Attachment doesn’t exist Finds all objects that are not related 
to Attachment; that is, all objects 
that do not have an attachment.

equals Administrator Person;Account equals 
Andrews

Logging equals 5

Finds all persons that are related to 
the account Andrews.

Finds all objects whose logging level 
is set to 5.

exists Calculation rule exists Finds all objects that are associated 
with any calculation rule.

in the last 7 days Person: date of birth in the last 7 days Finds all persons who were born 
within the last 7 days.

in the next 7 days Person: date of birth in the next 7 
days

Finds all persons who will be born 
within the next 7 days.

in tree with root Administrator Person;Organization 
in tree with root Hewlett-Packard

Finds all persons that are related to 
the organization Hewlett-Packard.

is (exactly) Label is (exactly) “Andrews” Finds all objects whose label matches 
exactly the keyword Andrews.

is at least Logging is at least 3 Finds all objects whose logging level 
is equal to or higher than 3.

is at most Logging is at most 10 Finds all objects whose logging level 
is equal to or lower than 10.
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is between Logging is between 3 and 10 Finds all objects whose logging level 
is between 3 and 10.

is empty Label is empty Finds all objects whose label 
attribute is empty.

is less than Logging is less than 1 Finds all objects whose logging level 
is less than 1; that is, all objects 
where logging is not enabled.

is more than Logging is more than 0 Finds all objects whose logging level 
is more than 0; that is, all objects 
where logging is enabled.

is not between Logging is not between 4 and 19 Finds all objects whose logging level 
is below 4 and above 19.

is not empty Label is not empty Finds all objects whose label 
attribute is not empty.

last month Person: date of birth last month Finds all persons who were born last 
month.

last week Person: date of birth last week Finds all persons who were born last 
week.

next month Person: date of birth next month Finds all persons who will be born 
next month.

next week Person: date of birth next week Finds all persons who will be born 
next week.

not equal to Administrator Person;Account not 
equal to Andrews

Logging not equal to 4

Finds all persons that are related to 
any account but Andrews.

Finds all objects whose logging level 
is anything but 4.

not equal to or null Administrator Person;Account not 
equal to or null Andrews

Logging not equal to or null 4

Finds all persons that are related to 
any account but Andrews or not 
related to an account at all.

Finds all objects whose logging level 
is anything but 4 or is not specified.

Table 4-1 Advanced Find Operators (Continued)

Operator Example Interpreted As
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not in tree with root Administrator Person;Organization 
not in tree with root Hewlett-Packard

Finds all persons that are not related 
to the organization Hewlett-Packard.

on Person: date of birth on 
February 13, 1973

Finds all persons who were born on 
February 13, 1971.

on or after Person: date of birth on or after 
February 13, 1973

Finds all persons who where born on 
February 13, 1971 or later.

on or before Person: date of birth on or before 
February 13, 1973

Finds all persons who where born on 
February 13, 1971 or before.

starts with Label starts with “toner cartridge” Finds all objects whose label starts 
with “toner cartridge”.

this month Person: date of birth this month Finds all persons who were born this 
month.

this week Person: date of birth this week Finds all persons who were born this 
week.

today Person: date of birth today Finds all persons who were born 
today.

tomorrow Person: date of birth tomorrow Finds all persons who will be born 
tomorrow.

yesterday Person: date of birth yesterday Finds all persons who were born 
yesterday.

Table 4-1 Advanced Find Operators (Continued)

Operator Example Interpreted As
Chapter 4 79



Using the Service Configuration Console
Using Wizards
Using Wizards
Wizards help you accomplish tasks by leading you step by step through a 
procedure. Figure 4-5 on page 81 shows an example of a wizard page. 

The title section includes the name of the wizard page and short 
instructions to help you better understand the task. Use the data fields 
to configure the object. On some wizard pages, additional dialogs can be 
opened so that you can further define the data. The summary section 
provides a quick overview over the different aspects of the object that is 
being configured by the wizard. 

You can use wizards in a variety of ways. Which way you choose depends 
on how familiar you are with the wizard and with the object you want to 
configure.

❏ Navigation buttons

If you are not yet familiar with the object you want to configure, use 
the < Prev. Page and Next Page> buttons to navigate step by step 
through the wizard. When you have completed all pages, click 
Finish to save your changes and to close the wizard.

❏ Summary section

If you are familiar with the object you want to configure, use the 
summary section to configure the object. 

Links in blue color let you quickly navigate to the wizard page where 
you can enter or change required information. Links in red color 
indicate required fields that have not been completed yet. 

Instead of using the data fields in the main section of the wizard 
page, you can also enter data directly into the summary section. 
When you click on data in the summary section, a small dialog box 
opens where you can enter the information directly. (Press Enter to 
save your changes and close the data field, and Esc to cancel.) 
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Figure 4-5 Example Showing a Wizard Page

See “Using Dialog Boxes” on page 82 for more information about dialog 
boxes.
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Using Dialog Boxes
Service Configuration dialog boxes come in different formats depending 
on the nature of the content:

❏ Property Dialog Boxes

See “Property Dialog Boxes” on page 83.

❏ Edit Dialog Boxes

See “Edit Dialog Boxes” on page 85.

❏ Standard Dialog Boxes

See “Standard Dialog Boxes” on page 86.

NOTE To help you identify required fields in dialog boxes, the fields are marked 
with an asterisk (*). Fields without the asterisk are optional. 
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Property Dialog Boxes

Object properties are displayed in a tabbed property dialog box with a 
menu bar and a toolbar. Figure 4-6 on page 84 shows an example of a 
property dialog box.

Property dialog boxes present the properties of an object in summary 
form. This helps you to quickly get an overview over the different 
properties of an object. If you want to edit the properties of an object, 
click the link in the tab. The property edit dialog for that attribute or 
association is presented where you can make changes.

You can also perform operations in property dialog boxes. These 
operations are available through the menu items in the menu bar and 
the buttons in the toolbar. For example, you can associate or disassociate 
the object for which you are currently viewing properties with an action. 
On the Associations tab, you can also sort associations.
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Figure 4-6 Example Showing a Property Dialog Box

See also “Edit Dialog Boxes” on page 85.
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Edit Dialog Boxes

Edit dialog boxes enable you to modify the properties of any Service 
Configuration object. You access property edit dialogs by clicking links in 
property dialog boxes. Figure 4-7 on page 85 shows an example of an edit 
dialog box.

The main part of the edit dialog box is the property section. This section 
displays the attributes and values that define the object. Depending on 
the type of attribute, the section can contain simple data fields or 
complex lists. 

If you have accessed an edit dialog box by accident or changed your mind 
about editing the properties, simply click the Cancel button to close the 
dialog box. If you have made any changes and want to save them, click 
the Apply or OK button. Apply saves your changes but does not close the 
dialog box. If applicable, data displayed in the console is updated 
immediately. OK saves your changes and closes the dialog box.

Figure 4-7 Example Showing an Edit Dialog Box

See also “Standard Dialog Boxes” on page 86.
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Standard Dialog Boxes

Standard dialog boxes let you configure Service Configuration objects 
such as actions, propagation rules, and calculation rules. Depending on 
the type of object, standard dialog boxes can have a simple or more 
complex layout. Figure 4-8 on page 87 shows an example of a standard 
dialog box.

Simple standard dialog boxes let you configure new or edit existing 
Service Configuration actions and rules. They have text entry fields 
where you can enter or modify data.

Complex standard dialog boxes show a list of objects in list boxes. To 
work with an object, select it in the list box and click the appropriate 
button. Summary sections show you at a glance the properties of the 
selected object.
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Figure 4-8 Example Showing a Standard Dialog Box with a Complex Layout

See also “Property Dialog Boxes” on page 83.
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Exiting the Service Configuration Console
When you have finished working with Service Configuration, close the 
console window and exit the application.

Before Service Configuration shuts down, an alert box asks if you want 
to save any changes you have made. 

To exit the Service Configuration console:

1. Select Exit from the File menu.

2. If you have not saved your latest changes, you are prompted to save 
them now.

See also “Starting the Service Configuration Console” on page 48.
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Glossary
A

action An operation that can be 
carried out by an OpenView 
application. Actions are typically 
performed on managed objects. 
Actions can be manually executed 
by users through a menu item or 
toolbar buttons. Actions can also 
be configured to automatically 
occur in response to an event, 
message, or a change in 
information in the management 
database.

activate To make active or 
functional.

adapter  Software that allows 
interoperability between two or 
more software products or 
components. 

advanced customization Less 
common types of customization 
which are more flexible in their 
capabilities and complex in their 
implementation than typical 
customizations. As with other 
customizations, advanced 
customizations are done to meet 
the needs and preferences of a 
particular customer or user. 

agent A program or process 
running on a remote device or 
computer system that responds to 
management requests, performs 
management operations, and/or 
sends performance and event 
notification. An agent can provide 
access to managed objects and 
MIB variables, interpret policy for 
resources and do configuration of 
resources.

API See application program 
interface (API). 

application Packaged software 
that provides functionality that is 
designed to accomplish a set of 
related tasks. An application is 
generally more complex than a 
tool. 

application program interface 
(API)  An interface that enables 
programmatic access to an 
application. 

ASCII  American Standard Code 
for Information Interchange. 

attribute  An attribute is a 
characteristic or property of an 
object that can be described 
through a name value pair. An 
example of an attribute for a 
person would be Name: John 
Smith. 

attribute name-value pair  An 
attribute name-value pair is a 
combination of an attribute 
identifier and the value of that 
attribute for a specific object. An 
example of an attribute 
name-value pair for a person 
would be Name: John Smith. 

B

badge A miniature icon, placed 
on or near an object's main icon, 
that provides information about 
the object's characteristics. 
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Boolean operator A logical operator that defines the context in which 
attribute values will be compared to satisfy a query or policy. The 
operators tell the system that: 

AND Both conditions have to be satisfied.

OR At least one condition has to be satisfied.

NOT No instance of this condition is allowed. 

browser A module within a workspace that presents one or more views 
of objects and provides functionality for interacting with the objects and 
the views.

C

child object An entry in an object hierarchy that has a relationship to 
one or more parent objects within the hierarchy. A child object can at the 
same time be the parent of one or more child objects. 

client A program or executable process that requests a service from a 
server 

client  A computer system on a network that accesses a service from 
another computer (server).

client console An instance of the user interface that appears on the 
client system while the application runs on a server. 

command  An instruction to a computer program that causes a specified 
operation to be carried out. Commands are typically typed by users on a 
command line. 

configuration The combination of settings of software parameters and 
attributes that determine the way the software works, the way it is used, 
and/or how it appears. The combination of settings of software 
parameters and attributes that determine the way the software works, 
the way it is used, and/or how it appears. 

configuration file A file that contains specifications or information 
that can be used for determining how a software program should look 
and operate. 
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configure To define and/or modify specified software settings to fulfill 
the requirements of a specified environment, application and/or usage.

console  An instance of the user interface from which the user can 
control an application or set of applications. 

customer An entity (person or organization) that receives services 
offered by a service provider. Typically services are provided to a 
customer based on a contractual relationship. 

customization The process of designing, constructing and/or modifying 
software to meet the needs and preferences of a particular customer or 
user.

customize To design, construct and/or modify software to meet the 
needs and preferences of a particular customer or user.

D

database A repository of data that is electronically stored. Typically 
databases are organized so that data can be retrieved and updated.

deactivate To deliberately stop a component or object from working.

deploy To install and activate software, hardware, capabilities, and/or 
services so that they work in the business environment.

deployment The process of installing and activating software, 
hardware, capabilities and/or services so that they work in the business 
environment. 

double-click  To press and release a pointing device's button twice in 
rapid succession. Double-clicking is a time-dependent action. Clicking 
twice in the same location at slow speed (click-delay-click) is not a 
double-click. 

dynamic parameters  Parameters whose values are determined 
during program execution. 

E

error log  An output file containing error messages. 
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export To format and move information from the current application to 
a location outside the current application.

F

filter A software feature or program that functions to screen data so that 
only a subset of the data is presented or passed. Filters allow 
matching-relevant information to be extracted and acted on while 
non-matching-irrelevant information is held back. 

find The act of seeking of specific data or objects within the management 
application or set management applications based on specified criteria.

G

group A collection of elements that can be treated as a unit. The set of 
elements in a group may be based on a rule specifying characteristics of 
group members or it may be arbitrary based on user selection. 
Assignments of associations and parameters can be made at the group 
level and inherited by the members of the group.

H

hierarchy Elements organized in successive levels with each lower level 
being subordinate to the one above.

HP OpenView  A family of network and system management products, 
and an architecture for those products. HP OpenView includes 
development environments and a wide variety of management 
applications. 

I, J, K

icon An on-screen image that represents objects that can be monitored 
or manipulated by the user or actions that can be executed by the user.

identifier  A name that within a given scope that uniquely identifies the 
object with which it is associated. 

import To format and move information from a location outside the 
current application into the current application.
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install  To load a product or component of a product onto a computer 
system or other network or system device. Installation typically involves 
running initial configuration scripts that are part of the installation 
process. 

L

list A set of selectable items. 

M

managed node  A computer system or device in a network that is both 
monitored for performance, status and messages and is manipulated by 
means of actions in the management software.

managed object  A network, system, software or service object that is 
both monitored for performance, status and messages and is 
manipulated by means of actions in the management software.

management server A server that provides management services, 
processes, and/or a management user interface to clients. 

map  A view of objects in the management environment (for example, 
systems, services, devices) in a format that shows one or more topological 
relationships between the objects.

message  A structured, readable notification that is generated as a 
result of an event, the evaluation of one or more events relative to 
specified conditions, or a change in application, system, network, or 
service status.

message browser A graphical user interface that presents notifications 
that are generated as a result of an event, the evaluation of one or more 
events relative to specified conditions or a change in application, system, 
network, or service status.

message description  Detailed information about an event or message. 

message severity level  A property of a message indicating the level of 
impact of the event or notification that initiated the message. 

metadata  Data that defines data. 
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monitored object A network, system, software or service object that is 
monitored for performance, status and messages by the management 
software.
Note that monitored objects cannot be manipulated by the management 
software.

N

node  A computer system or device (for example, printer, router, bridge) 
in a network. 

O

object A logical or physical entity that can be described by a distinct 
named set of attributes. Examples of objects are a customer, a service, a 
network, a computer, an interface, or a process. 

object hierarchy Specification of parent-child relationships (in terms 
of grouping, not inheritance) to create a tree-like structure and the 
specification of views for each object in the structure. Each parent in the 
object hierarchy can have more than one child, and each child can have 
one or more parents.

object identifier (OID) A unique sequence of numbers or string of 
characters used for specifying the identity of an object. This identifier is 
obtained from either an authorized registration authority or an 
algorithm designed to generate universally unique values. 

object rule A rule that determines what conditions must be met before 
an object will be classified as a child object or a parent in an object 
hierarchy.

object type An abstraction or categorization of objects based on the 
attributes of the object. Examples of object types are services, customers, 
hardware elements.

operator  The role of a person who uses a management application to 
perform a specified subset of management tasks. 

operator console A management console that is constrained to provide 
functionality that is consistent with operator level tasks. 
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P, Q

parameter  A variable or attribute that may be given an arbitrary value 
for use during an execution of either a computer program or a procedure 
within a program. 

parameter group A set of parameter values that have been categorized 
together on some logical basis. A parameter group can be applied to a 
variable as a set allowing multiple values to be assigned with one 
operation.

parameter type An abstraction or categorization of a parameter that 
determines the particular kind of data that is valid for the parameter. 
For example a parameter type could be IP Address which indicates that 
parameter values must have 4 numbers separated by decimals with the 
value for each number being in the range of 0 to 255.

parameter value A value that is given to a variable.

parent object An entry in an object hierarchy that has one or more 
child objects in the hierarchy. A parent object can at the same time be the 
child of another parent object.

path A sequence of directory names separated by slashes that specifies 
the location of any file or directory. 

port  A location for passing information into and out of a network device. 

process  A coordinated set of activities directed to achieve a business 
goal. 

R

refresh To bring up to date. The process of refreshing synchronizes the 
data that is loaded in a client console with the data available on the 
server. Refreshing includes bringing in new data as well as removing 
obsolete data.

reserved word  Words that have special meaning in Service 
Configuration and cannot be used for any other kind of identifier. 
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root object Topmost object or objects in an object hierarchy. A root 
object does not have a parent object.

S

server A program or executable process that responds to and services 
requests issued by clients. 

server A computer system that provides a service (for example, 
management capabilities, file storage capabilities) to other computer 
systems (clients) on the network. 

service A customer-based or user-oriented functionality (for example, 
E-mail, network bandwidth, application access) provided by a set of 
service resources. 

service contract A contract between a service provider and a customer 
that is designed to create a common understanding about services, 
priorities, responsibilities, and price. Service contracts may or may not 
include Service Level Agreements (SLAs). 

service hierarchy A type of object hierarchy with a service being the 
root object.

service level agreement (SLA)  A negotiated agreement between the 
service provider and the customer that contains agreed upon Service 
Level Objectives ( performance, availability, and so on) that specify the 
Quality of Service (QoS) to be maintained. It also contains processes and 
procedures to be followed when the objective is not met. 

service level management  The set of management functions that 
enables the process of measuring, reporting, and improving the quality of 
service being provided. 

service level objective (SLO)  A component within an SLA that 
specifies a Quality of Service metric and value that is to be met subject to 
specified constraints (for example, in a specified time frame). 

service model  A representation of the relationship between 
components of a service. 
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service offering  A collection of different services that make up the 
products offered by a service provider. For example, a service offering can 
be a single service such as email or a bundled service like “web-hosting” 
that consists of the services: ”web page hosting”, “e-mail”, and “customer 
help desk”. 

service provider  A company or organization that provides services to 
customers. 

service report  A report that provides information about the 
functioning and status of one or more services.

service resource A hardware or software component or an underlying 
communication medium that is used to provide a service.

severity level  A property of an object indicating the status of the 
object. Severity level is based on the impact of events or messages 
associated with the object.

Smart Plug-in (SPI)  Prepackaged software that installs into a 
management console and provides management capabilities specific to a 
given type of business application, database, operating system, or 
service.

status calculation  Process used to determine the status of a service or 
object based on the status of the source objects that contribute to the 
status of the service or object. 

status propagation  The way that the status of a status source is 
defined for status calculation of an object.

status propagation rule  An algorithm or specification that 
determines how a status source will impact the overall status of an 
another object (for example, service, group).

status source An object or objects (for example, message, service, node, 
event) whose severity level or status contributes to the status of another 
object.

syntax  The rules governing the structure and content of a language or 
the description of an object. 
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system administrator  The role of a person who does configuration and 
maintenance on a computer system and/or the software on the system. 

T

tab A page in the user interface that has a small index-card like 
projection. The projection typically presents the name for the page and 
allows navigation to the page by clicking. 

target A network element, system, device, interface or software 
component to which management software or policies will be deployed, or 
on which actions will be executed. 

terminate  To permanently stop the execution of a computer operation. 

U

UI server  A server that can provide user interface components and 
data to multiple client consoles. 

uninstall  To remove previously installed software. 

user A person who uses a software application, a computer or service. A 
user can have one or more roles. For example, a network administrator 
or operator role.

user configuration file A configuration file that contains specifications 
or information that can be used for determining how a software program 
should look and operate for a given user. 

user ID  An identifier that uniquely identifies a principal that is a 
person. 

V

view  A data presentation usually in graphical or tabular format. Views 
allow users to obtain information on the objects (for example, status) and 
may allow interaction with the objects.

view type A categorization of the presentation format for a view. View 
types include table, chart, graphical, tree, and explorer.
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W, Z, Y, Z

workspace A working area within the OpenView Console that provides 
views of objects and and access to functionality from the perspective of a 
given task domain. The objects presented and the actions that are most 
readily available are scoped by the context of the task domain. 
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A
about

actions, 27
adding child objects, 23
configuring OVO management servers, 20
nodes, 27
Service Hierarchy Wizard, 21

actions, about, 27
additional information, 37
Advanced Find

associations tab, 74
attributes tab, 72
operators, 77
search results, 76
using, 71

attributes tab, using to find objects, 72

C
cautions in online help, 42
child objects, adding, 23
comments, 43
configuring status objects, 25
console

Service Configuration
Advanced Find, 71
collapsing service hierarchies, 56
copying and pasting, 63
customizing, 52
edit dialog boxes, 85
exiting, 88
expanding service hierarchies, 56
finding objects, 68
finding objects using associations tab, 74
finding objects using attributes tab, 72
getting to know, 50
hiding excluded objects, 58
hiding origin badges, 59
hiding Scope pane, 55
multiple instances, 60
property dialog boxes, 83
Quick Find, 69
resizing Scope and Result pane, 54
resizing window, 53
showing excluded objects, 58
showing origin badges, 59
showing Scope pane, 55
standard dialog boxes, 86
starting, 48
using, 47

using dialog boxes, 82
using wizards, 80
working with search results, 76

console, Service Configuration, 19
copying and pasting

Service Configuration Console, 63
in dialog boxes, 65
within the service hierarchy, 64

Service Configuration console
between service hierarchies, 66

creating service hierarchies with objects, 18
customizing the Service Configuration 

Console, 52

D
deploying service hierarchies to Service 

Navigator, 29
dialog boxes

edit, 85
property, 83
standard, 86
using, 82

disabling
multiple notification, 62

documentation, user, 44
don’t show messages, 62

E
edit dialog boxes, 85
excluded objects

Service Configuration Console
hiding, 58
showing, 58

exiting the Service Configuration Console, 88

F
finding objects

about, 68
using associations tab, 74
using attributes tab, 72

G
getting help

HP Response Center, 43
user documentation, 44

getting to know the Service Configuration 
Console, 50

GUI tour, 17
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H
help, how to get, 38
help, online

cautions, 42
links, 40
notes, 42
tips, 42

HP OpenView web site, 46
HP Response Center, 43

I
information, additional, 37
integration, Service Configuration and 

Service Desk, 31

L
links in online help, 40

M
messages

disabling multiple, 62

N
nodes, about, 27
notes in online help, 42
notification

disabling, 62

O
objects

child, adding, 23
configuring status, 25
creating service hierarchies with, 18
excluded

hiding, 58
finding, 68

using associations tab, 74
using attributes tab, 72

Service Desk
adding manually, 35
adding rule-based, 32

showing excluded, 58
online help

cautions, 42
links, 40
notes, 42
tips, 42

operators

in Advanced Find, 77
origin badges, console

hiding, 59
showing, 59

OVO management servers, configuring, 20

P
property dialog boxes, 83

Q
Quick Find

changing, 70
using, 69

R
resizing Service Configuration Console

Scope and Result pane, 54
window, 53

S
Scope pane, Service Configuration Console

hiding, 55
showing, 55

search results, working with, 76
Service Configuration

integration with Service Desk, 31
main console, 19
welcome, 11

Service Configuration Console
collapsing service hierarchies, 56
copying and pasting, 63

between service hierarchies, 66
in dialog boxes, 65
within the service hierarchy, 64

customizing, 52
edit dialog boxes, 85
exiting, 88
expanding service hierarchies, 56
finding objects, 68

using associations tab, 74
using attributes tab, 72

getting to know, 50
hiding

excluded objects, 58
origin badges, 59
Scope pane, 55

multiple instances, 60
property dialog boxes, 83
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resizing
Scope and Result pane, 54
window, 53

showing
excluded objects, 58
origin badges, 59
Scope pane, 55

standard dialog boxes, 86
starting, 48
using, 47

Advanced Find, 71
dialog boxes, 82
Quick Find, 69
wizards, 80

working with
search results, 76

zooming map view, 57
Service Desk

adding child objects
manually, 35
rule-based, 32

Service Desk child objects, adding
manually, 35
rule-based, 32

Service Desk, integration with Service 
Configuration, 31

service hierarchies
collapsing in Service Configuration

Console, 56
creating with objects, 18
deploying to Service Navigator, 29
expanding in Service Configuration

Console, 56
Service Hierarchy Wizard, about, 21
Service Navigator, deploying service 

hierarchies to, 29
services

zooming map view, 57
sort order

changing in Quick Find, 70
standard dialog boxes, 86
starting Service Configuration console, 48
status, configuring for objects, 25

T
take the tour, 17
tips in online help, 42
tour, GUI, 17

U
user documentation, 44
using

dialog boxes, 82
edit, 85
property, 83
standard, 86

Service Configuration console, 47
wizards, 80

W
welcome to Service Configuration, 11
wizards, using, 80
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